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Notice
While reasonable efforts have been made to ensure that the
information in this document is complete and accurate at the time of
printing, Avaya assumes no liability for any errors. Avaya reserves
the right to make changes and corrections to the information in this
document without the obligation to notify any person or organization
of such changes.
Documentation disclaimer
“Documentation” means information published in varying mediums
which may include product information, operating instructions and
performance specifications that are generally made available to users
of products. Documentation does not include marketing materials.
Avaya shall not be responsible for any modifications, additions, or
deletions to the original published version of Documentation unless
such modifications, additions, or deletions were performed by or on
the express behalf of Avaya. End User agrees to indemnify and hold
harmless Avaya, Avaya's agents, servants and employees against all
claims, lawsuits, demands and judgments arising out of, or in
connection with, subsequent modifications, additions or deletions to
this documentation, to the extent made by End User.
Link disclaimer
Avaya is not responsible for the contents or reliability of any linked
websites referenced within this site or Documentation provided by
Avaya. Avaya is not responsible for the accuracy of any information,
statement or content provided on these sites and does not
necessarily endorse the products, services, or information described
or offered within them. Avaya does not guarantee that these links will
work all the time and has no control over the availability of the linked
pages.
Warranty
Avaya provides a limited warranty on Avaya hardware and software.
Refer to your sales agreement to establish the terms of the limited
warranty. In addition, Avaya’s standard warranty language, as well as
information regarding support for this product while under warranty is
available to Avaya customers and other parties through the Avaya
Support website: https://support.avaya.com/helpcenter/
getGenericDetails?detailId=C20091120112456651010 under the link
“Warranty & Product Lifecycle” or such successor site as designated
by Avaya. Please note that if You acquired the product(s) from an
authorized Avaya Channel Partner outside of the United States and
Canada, the warranty is provided to You by said Avaya Channel
Partner and not by Avaya.
“Hosted Service” means an Avaya hosted service subscription that
You acquire from either Avaya or an authorized Avaya Channel
Partner (as applicable) and which is described further in Hosted SAS
or other service description documentation regarding the applicable
hosted service. If You purchase a Hosted Service subscription, the
foregoing limited warranty may not apply but You may be entitled to
support services in connection with the Hosted Service as described
further in your service description documents for the applicable
Hosted Service. Contact Avaya or Avaya Channel Partner (as
applicable) for more information.
Hosted Service
THE FOLLOWING APPLIES ONLY IF YOU PURCHASE AN AVAYA
HOSTED SERVICE SUBSCRIPTION FROM AVAYA OR AN AVAYA
CHANNEL PARTNER (AS APPLICABLE), THE TERMS OF USE
FOR HOSTED SERVICES ARE AVAILABLE ON THE AVAYA
WEBSITE, HTTPS://SUPPORT.AVAYA.COM/LICENSEINFO UNDER
THE LINK “Avaya Terms of Use for Hosted Services” OR SUCH
SUCCESSOR SITE AS DESIGNATED BY AVAYA, AND ARE
APPLICABLE TO ANYONE WHO ACCESSES OR USES THE
HOSTED SERVICE. BY ACCESSING OR USING THE HOSTED
SERVICE, OR AUTHORIZING OTHERS TO DO SO, YOU, ON
BEHALF OF YOURSELF AND THE ENTITY FOR WHOM YOU ARE
DOING SO (HEREINAFTER REFERRED TO INTERCHANGEABLY
AS “YOU” AND “END USER”), AGREE TO THE TERMS OF USE. IF
YOU ARE ACCEPTING THE TERMS OF USE ON BEHALF A
COMPANY OR OTHER LEGAL ENTITY, YOU REPRESENT THAT
YOU HAVE THE AUTHORITY TO BIND SUCH ENTITY TO THESE
TERMS OF USE. IF YOU DO NOT HAVE SUCH AUTHORITY, OR IF

YOU DO NOT WISH TO ACCEPT THESE TERMS OF USE, YOU
MUST NOT ACCESS OR USE THE HOSTED SERVICE OR
AUTHORIZE ANYONE TO ACCESS OR USE THE HOSTED
SERVICE.
Licenses
THE SOFTWARE LICENSE TERMS AVAILABLE ON THE AVAYA
WEBSITE, HTTPS://SUPPORT.AVAYA.COM/LICENSEINFO,
UNDER THE LINK “AVAYA SOFTWARE LICENSE TERMS (Avaya
Products)” OR SUCH SUCCESSOR SITE AS DESIGNATED BY
AVAYA, ARE APPLICABLE TO ANYONE WHO DOWNLOADS,
USES AND/OR INSTALLS AVAYA SOFTWARE, PURCHASED
FROM AVAYA INC., ANY AVAYA AFFILIATE, OR AN AVAYA
CHANNEL PARTNER (AS APPLICABLE) UNDER A COMMERCIAL
AGREEMENT WITH AVAYA OR AN AVAYA CHANNEL PARTNER.
UNLESS OTHERWISE AGREED TO BY AVAYA IN WRITING,
AVAYA DOES NOT EXTEND THIS LICENSE IF THE SOFTWARE
WAS OBTAINED FROM ANYONE OTHER THAN AVAYA, AN AVAYA
AFFILIATE OR AN AVAYA CHANNEL PARTNER; AVAYA
RESERVES THE RIGHT TO TAKE LEGAL ACTION AGAINST YOU
AND ANYONE ELSE USING OR SELLING THE SOFTWARE
WITHOUT A LICENSE. BY INSTALLING, DOWNLOADING OR
USING THE SOFTWARE, OR AUTHORIZING OTHERS TO DO SO,
YOU, ON BEHALF OF YOURSELF AND THE ENTITY FOR WHOM
YOU ARE INSTALLING, DOWNLOADING OR USING THE
SOFTWARE (HEREINAFTER REFERRED TO
INTERCHANGEABLY AS “YOU” AND “END USER”), AGREE TO
THESE TERMS AND CONDITIONS AND CREATE A BINDING
CONTRACT BETWEEN YOU AND AVAYA INC. OR THE
APPLICABLE AVAYA AFFILIATE (“AVAYA”).
Avaya grants You a license within the scope of the license types
described below, with the exception of Heritage Nortel Software, for
which the scope of the license is detailed below. Where the order
documentation does not expressly identify a license type, the
applicable license will be a Designated System License as set forth
below in the Designated System(s) License (DS) section as
applicable. The applicable number of licenses and units of capacity
for which the license is granted will be one (1), unless a different
number of licenses or units of capacity is specified in the
documentation or other materials available to You. “Software” means
computer programs in object code, provided by Avaya or an Avaya
Channel Partner, whether as stand-alone products, pre-installed on
hardware products, and any upgrades, updates, patches, bug fixes,
or modified versions thereto. “Designated Processor” means a single
stand-alone computing device. “Server” means a set of Designated
Processors that hosts (physically or virtually) a software application
to be accessed by multiple users. “Instance” means a single copy of
the Software executing at a particular time: (i) on one physical
machine; or (ii) on one deployed software virtual machine (“VM”) or
similar deployment.
License types
Designated System(s) License (DS). End User may install and use
each copy or an Instance of the Software only: 1) on a number of
Designated Processors up to the number indicated in the order; or 2)
up to the number of Instances of the Software as indicated in the
order, Documentation, or as authorized by Avaya in writing. Avaya
may require the Designated Processor(s) to be identified in the order
by type, serial number, feature key, Instance, location or other
specific designation, or to be provided by End User to Avaya through
electronic means established by Avaya specifically for this purpose.
Heritage Nortel Software
“Heritage Nortel Software” means the software that was acquired by
Avaya as part of its purchase of the Nortel Enterprise Solutions
Business in December 2009. The Heritage Nortel Software is the
software contained within the list of Heritage Nortel Products located
at https://support.avaya.com/LicenseInfo under the link “Heritage
Nortel Products” or such successor site as designated by Avaya. For
Heritage Nortel Software, Avaya grants Customer a license to use
Heritage Nortel Software provided hereunder solely to the extent of
the authorized activation or authorized usage level, solely for the
purpose specified in the Documentation, and solely as embedded in,
for execution on, or for communication with Avaya equipment.
Charges for Heritage Nortel Software may be based on extent of
activation or use authorized as specified in an order or invoice.
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Copyright
Except where expressly stated otherwise, no use should be made of
materials on this site, the Documentation, Software, Hosted Service,
or hardware provided by Avaya. All content on this site, the
documentation, Hosted Service, and the product provided by Avaya
including the selection, arrangement and design of the content is
owned either by Avaya or its licensors and is protected by copyright
and other intellectual property laws including the sui generis rights
relating to the protection of databases. You may not modify, copy,
reproduce, republish, upload, post, transmit or distribute in any way
any content, in whole or in part, including any code and software
unless expressly authorized by Avaya. Unauthorized reproduction,
transmission, dissemination, storage, and or use without the express
written consent of Avaya can be a criminal, as well as a civil offense
under the applicable law.
Virtualization
The following applies if the product is deployed on a virtual machine.
Each product has its own ordering code and license types. Unless
otherwise stated, each Instance of a product must be separately
licensed and ordered. For example, if the end user customer or
Avaya Channel Partner would like to install two Instances of the
same type of products, then two products of that type must be
ordered.
Third Party Components
“Third Party Components” mean certain software programs or
portions thereof included in the Software or Hosted Service may
contain software (including open source software) distributed under
third party agreements (“Third Party Components”), which contain
terms regarding the rights to use certain portions of the Software
(“Third Party Terms”). As required, information regarding distributed
Linux OS source code (for those products that have distributed Linux
OS source code) and identifying the copyright holders of the Third
Party Components and the Third Party Terms that apply is available
in the products, Documentation or on Avaya’s website at: https://
support.avaya.com/Copyright or such successor site as designated
by Avaya. The open source software license terms provided as Third
Party Terms are consistent with the license rights granted in these
Software License Terms, and may contain additional rights benefiting
You, such as modification and distribution of the open source
software. The Third Party Terms shall take precedence over these
Software License Terms, solely with respect to the applicable Third
Party Components to the extent that these Software License Terms
impose greater restrictions on You than the applicable Third Party
Terms.
The following applies only if the H.264 (AVC) codec is distributed with
the product. THIS PRODUCT IS LICENSED UNDER THE AVC
PATENT PORTFOLIO LICENSE FOR THE PERSONAL USE OF A
CONSUMER OR OTHER USES IN WHICH IT DOES NOT RECEIVE
REMUNERATION TO (i) ENCODE VIDEO IN COMPLIANCE WITH
THE AVC STANDARD (“AVC VIDEO”) AND/OR (ii) DECODE AVC
VIDEO THAT WAS ENCODED BY A CONSUMER ENGAGED IN A
PERSONAL ACTIVITY AND/OR WAS OBTAINED FROM A VIDEO
PROVIDER LICENSED TO PROVIDE AVC VIDEO. NO LICENSE IS
GRANTED OR SHALL BE IMPLIED FOR ANY OTHER USE.
ADDITIONAL INFORMATION MAY BE OBTAINED FROM MPEG LA,
L.L.C. SEE HTTP://WWW.MPEGLA.COM.
Service Provider
THE FOLLOWING APPLIES TO AVAYA CHANNEL PARTNER’S
HOSTING OF AVAYA PRODUCTS OR SERVICES. THE PRODUCT
OR HOSTED SERVICE MAY USE THIRD PARTY COMPONENTS
SUBJECT TO THIRD PARTY TERMS AND REQUIRE A SERVICE
PROVIDER TO BE INDEPENDENTLY LICENSED DIRECTLY FROM
THE THIRD PARTY SUPPLIER. AN AVAYA CHANNEL PARTNER’S
HOSTING OF AVAYA PRODUCTS MUST BE AUTHORIZED IN
WRITING BY AVAYA AND IF THOSE HOSTED PRODUCTS USE
OR EMBED CERTAIN THIRD PARTY SOFTWARE, INCLUDING
BUT NOT LIMITED TO MICROSOFT SOFTWARE OR CODECS,
THE AVAYA CHANNEL PARTNER IS REQUIRED TO
INDEPENDENTLY OBTAIN ANY APPLICABLE LICENSE
AGREEMENTS, AT THE AVAYA CHANNEL PARTNER’S EXPENSE,
DIRECTLY FROM THE APPLICABLE THIRD PARTY SUPPLIER.
WITH RESPECT TO CODECS, IF THE AVAYA CHANNEL
PARTNER IS HOSTING ANY PRODUCTS THAT USE OR EMBED
THE H.264 CODEC OR H.265 CODEC, THE AVAYA CHANNEL

PARTNER ACKNOWLEDGES AND AGREES THE AVAYA
CHANNEL PARTNER IS RESPONSIBLE FOR ANY AND ALL
RELATED FEES AND/OR ROYALTIES. THE H.264 (AVC) CODEC
IS LICENSED UNDER THE AVC PATENT PORTFOLIO LICENSE
FOR THE PERSONAL USE OF A CONSUMER OR OTHER USES
IN WHICH IT DOES NOT RECEIVE REMUNERATION TO: (I)
ENCODE VIDEO IN COMPLIANCE WITH THE AVC STANDARD
(“AVC VIDEO”) AND/OR (II) DECODE AVC VIDEO THAT WAS
ENCODED BY A CONSUMER ENGAGED IN A PERSONAL
ACTIVITY AND/OR WAS OBTAINED FROM A VIDEO PROVIDER
LICENSED TO PROVIDE AVC VIDEO. NO LICENSE IS GRANTED
OR SHALL BE IMPLIED FOR ANY OTHER USE. ADDITIONAL
INFORMATION FOR H.264 (AVC) AND H.265 (HEVC) CODECS
MAY BE OBTAINED FROM MPEG LA, L.L.C. SEE HTTP://
WWW.MPEGLA.COM.
Compliance with Laws
You acknowledge and agree that it is Your responsibility for
complying with any applicable laws and regulations, including, but not
limited to laws and regulations related to call recording, data privacy,
intellectual property, trade secret, fraud, and music performance
rights, in the country or territory where the Avaya product is used.
Preventing Toll Fraud
“Toll Fraud” is the unauthorized use of your telecommunications
system by an unauthorized party (for example, a person who is not a
corporate employee, agent, subcontractor, or is not working on your
company's behalf). Be aware that there can be a risk of Toll Fraud
associated with your system and that, if Toll Fraud occurs, it can
result in substantial additional charges for your telecommunications
services.
Avaya Toll Fraud intervention
If You suspect that You are being victimized by Toll Fraud and You
need technical assistance or support, call Technical Service Center
Toll Fraud Intervention Hotline at +1-800-643-2353 for the United
States and Canada. For additional support telephone numbers, see
the Avaya Support website: https://support.avaya.com or such
successor site as designated by Avaya.
Security Vulnerabilities
Information about Avaya’s security support policies can be found in
the Security Policies and Support section of https://
support.avaya.com/security.
Suspected Avaya product security vulnerabilities are handled per the
Avaya Product Security Support Flow (https://
support.avaya.com/css/P8/documents/100161515).
Downloading Documentation
For the most current versions of Documentation, see the Avaya
Support website: https://support.avaya.com, or such successor site
as designated by Avaya.
Contact Avaya Support
See the Avaya Support website: https://support.avaya.com for
product or Hosted Service notices and articles, or to report a problem
with your Avaya product or Hosted Service. For a list of support
telephone numbers and contact addresses, go to the Avaya Support
website: https://support.avaya.com (or such successor site as
designated by Avaya), scroll to the bottom of the page, and select
Contact Avaya Support.
Trademarks
The trademarks, logos and service marks (“Marks”) displayed in this
site, the Documentation, Hosted Service(s), and product(s) provided
by Avaya are the registered or unregistered Marks of Avaya, its
affiliates, its licensors, its suppliers, or other third parties. Users are
not permitted to use such Marks without prior written consent from
Avaya or such third party which may own the Mark. Nothing
contained in this site, the Documentation, Hosted Service(s) and
product(s) should be construed as granting, by implication, estoppel,
or otherwise, any license or right in and to the Marks without the
express written permission of Avaya or the applicable third party.
Avaya is a registered trademark of Avaya Inc.
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All non-Avaya trademarks are the property of their respective owners.
Linux® is the registered trademark of Linus Torvalds in the U.S. and
other countries.
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Chapter 1: Introduction

Purpose
This document describes how to deploy and configure Avaya Breeze® platform Kernel-based
Virtual Machine (KVM) OVA.

This document is intended for people who install and configure Avaya Breeze® platform KVM OVA
at a customer site.

Prerequisites
Before deploying the Avaya Breeze® platform KVM OVA, ensure that you have the following
knowledge, skills and tools.

Knowledge
• KVM hypervisor installation and set up
• Linux® Operating System
• Avaya Breeze® platform

Skills
To administer the KVM hypervisor and Avaya Breeze® platform.

Tools
For information about tools and utilities, see “Configuration tools and utilities”.
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Chapter 2: Overview

Kernel-based Virtual Machine overview
Kernel-based Virtual Machine (KVM) is a virtualization infrastructure for the Linux kernel that turns
the Linux kernel into a hypervisor. You can remotely access the hypervisor to deploy applications
on the KVM host.

KVM virtualization solution is:

• Cost effective for the customers.

• Performance reliable and highly scalable.

• Secure as it uses the advanced security features of SELinux.

• Open source software that can be customized as per the changing business requirements of
the customers.
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Chapter 3: Planning

Planning checklist
Ensure that you complete the following before deploying Avaya Breeze® platform on KVM:

No. Task Reference Notes

1 Download the required
software.

See Configuration tools
and utilities on page 10
and Release details of
Avaya Breeze platform
KVM OVA on page 10

2 Purchase the required
licenses.

—

3 Register for PLDS and activate
license entitlements.

Go to Avaya Product
Licensing and Delivery
System at https://
plds.avaya.com/.

4 Install the KVM hypervisor. —
5 Install the MobaXterm and

Xming softwares.
— To remotely access the

KVM hypervisor, use the
Virt Manager GUI or virsh
command line interface.

6 Record information that you
require for the deployment.

Key customer configuration
information on page 11

Supported tools
• Virt Manager: A user interface for managing virtual machines through libvirt.
• virsh: A command line interface tool for deploying the OVA.
• virt-manager or virt-viewer: A command line interface tool for configuring the OVA.
• OpenStack: A web-based user interface to OpenStack services.
• Nutanix: An end-to-end management solution for virtualized datacenter environments that

streamlines and automates common workflows, eliminating the need for multiple
management solutions across datacenter operations.
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• Red Hat Virtualization Manager: A feature-rich web interface to manage the virtual
infrastructure. Red Hat Virtualization Manager provides host management, guest
management, storage management, and high availability infrastructure.

Configuration tools and utilities
• Avaya Breeze® platform OVA

• A browser for accessing Avaya Breeze® platform

• PuTTY

• WinSCP

• MobaXterm

Release details of Avaya Breeze® platform KVM OVA
You can download the following OVA file from the Avaya PLDS website at http://plds.avaya.com/.

Product name Release version OVA file name
Avaya Breeze® platform 3.6 Breeze-3.6.0.0.xxxxxx-kvm-xxx.ova

Supported footprints

Product name Footprint Release CPUs (GHz) Number
of vCPUs

RAM (GB) HDD (GB) NICs

Presence
Services

Profile 2 3.5 2.2 4 8 80 2

Presence
Services

Profile 3 3.5 2.2 6 10 80 2

Presence
Services

Profile 4 3.5 2.2 8 16 150 2

Presence
Services

Profile 5 3.5 2.2 12 27 300 2

Planning
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Supported hardware
To deploy the Avaya Breeze® platform KVM OVA on a customer-provided server, the server must
be on the Red Hat supported server list for Red Hat Enterprise Linux 7.2 or 7.3.

Key customer configuration information
You require the following information to install and configure Avaya Breeze® platform. Have this
information before you begin the installation.

Network Settings

Field Information to enter Notes
IP Address Enter server’s IP address Management IP address to be

assigned to Avaya Breeze® platform.
Short Hostname Enter server’s hostname
Network Domain Enter network domain or

‘none’
Netmask Enter netmask
Default gateway Enter gateway IP address Default gateway for Avaya Breeze®

platform management network
interface.

DNS servers Enter the Primary,
Secondary, and Tertiary DNS
server IP address

You can have up to three DNS
servers.

Proxy settings

Field Information to enter Notes
HTTP Proxy Server Enter the IP address or

FQDN of the HTTP proxy
server.

HTTP Proxy Port Enter the HTTP proxy port.
HTTPS Proxy Server Enter the IP address or

FQDN of the HTTPS proxy
server.

HTTPS Proxy Port Enter the HTTPS proxy port.
HTTP Proxy exclusion list Enter the HTTPS proxy

severs with a delimiter of
“|”.

Table continues…

Supported hardware
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Field Information to enter Notes
For example, *ca.avaya.com|
*.us.avaya.com|135.9.95.*
By default, the customer domain will
be added to the proxy exclusion list.
The proxy exclusion list can be added
with the CEnetSetup command or
using the OVA properties during
deployment. If the destination for the
HTTP request matches any address
in the exclusion list, the HTTP
request will be sent directly to the
destination instead of the proxy.

System Time Settings

Field Information to enter Notes
Timezone Select the timezone from

this field.
This configuration is mandatory for
Avaya Breeze® platform to function.
The timezone configured on Avaya
Breeze® platform must match the
timezone on System Manager.

NTP Servers Enter IP/FQDN of Primary
NTP Server

You can have up to three NTP
servers.

Enter a value in this field only when
the VMware host does not
synchronize on its own.

User access

Field Information to enter Notes
Enhanced Access
Security Gateway
(EASG)

Enter one of the following:

• 1 to enable EASG.

• 2 to disable EASG.

Customer Login Settings

Field Information to enter Notes
Login Name Enter Login ID to use for

the customer account (cust).
Login ID and password for customer
account you will create during OVA
deployment.

Enter Password Enter the customer account
password.

Planning
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System Manager Settings

Field Information to enter Notes
Primary System Manager
IP

Enter the IP Address of the
Primary System Manager that will be
used to manage this Avaya Breeze®

platform server.
Enrollment Password Enter the Enrollment Password

that matches the value in System
Manager administration.

Note:

You must know the Enrollment
Password, and the password
must not have expired.

The password is set on System
Manager at Security >
Certificates > Enrollment
Password.

On this page, verify that the
Time Remaining is greater than
zero. If you do not know the
password, create a new one.

SIP Entity (Security Module Interface) Networking Information
This information is required for administering Avaya Breeze® platform SIP Entity and Avaya
Breeze® platforminstance.

Required information Value
IP address
Subnet Mask
Gateway

Key customer configuration information
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Chapter 4: Deployment

Prerequisites for deploying KVM OVA
Procedure

1. Access the KVM host remotely using MobaXterm.

2. Create a folder on the KVM host.

3. Copy the KVM OVA to the folder.

4. Run the command following command: tar -xvf Breeze-3.5.0.0.xxxxxx-kvm-
xxx.ova

The system extracts the files from the application KVM OVA.

5. Copy the qcow2 image to /var/lib/libvirt/images or an appropriate directory.

Deploying the OVA by using Virt Manager
Procedure

1. Log in to the KVM host by using MobaXterm.

2. Navigate to the KVM OVA directory.

3. Run the command: virt-manager.

4. In the Virtual Machine Manager window, click File > New Virtual Machine.

5. On the Create a new virtual machine Step 1 of 4 window, select Import existing disk
image.

6. Click Forward.

7. On the Create a new virtual machine Step 2 of 4 window, do the following:

a. In the Provide the existing storage path field, click Browse, and select the qcow2
image.

b. In the OS type field, select Linux.

c. In the Version field, select Red Hat Linux Enterprise 7.3.

d. Click Forward.
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8. On the Create a new virtual machine Step 3 of 4 window, do the following:

a. In Memory (RAM), enter the required memory based on the profile.
b. In CPUs, enter the number of CPUs for the virtual machine based on the profile.
c. Click Forward.

9. On the Create a new virtual machine Step 4 of 4 window, do the following:

a. In the Name field, assign a name to the virtual machine.
b. Select the Customize Configuration before Install check box.
c. In the Network selection field, verify the required network interface.
d. Click Finish.

10. In the navigation pane, click Add Hardware, and do the following:

a. In the Advanced options section, click Network.
b. In the Network source field, select the required network source.
c. Change the device to virtio.
d. Click Finish.
e. Click Apply.

11. Click Begin Installation.

The system creates the virtual machine.

12. Configure the virtual machine.

Related links
Configuring the virtual machine on page 30

Deploying the OVA by using CLI
Procedure

1. Log in to the KVM host CLI by using PuTTY.

2. Navigate to the KVM OVA directory.

3. Run the command: bash Breeze-3.5-s1-KVM-installer.sh
4. In the Enter Profile field, type the required Avaya Breeze® platform profile:

• 2
• 3
• 4
• 5

For more information, see “Supported footprints”.

Deploying the OVA by using CLI
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5. In the Enter VM name [Breeze] field, type the name of the virtual machine.

6. In the Enter drive storage location field, type the storage location.

7. In the Public field, select the appropriate network.

8. In the Out of Band Management field, select the appropriate network.

9. Type Y to continue.

The system displays the following:
Deploying image

Starting install...
Creating domain...
Domain Creation completed.

Next steps
Configure the virtual machine.

Related links
Supported footprints on page 10
Configuring the virtual machine on page 30

Deploying application by using OpenStack

Connecting to OpenStack Dashboard
Before you begin

• Create an OpenStack account.
• Acquire adequate permission to upload and deploy the KVM ova.

Procedure
1. In your web browser, type the OpenStack URL.

For example, http://<openstack.xyz.com>/horizon.

2. In Domain, type the domain name.

3. In User Name, type the user name.

4. Click Connect.

The system displays the Instance Overview - OpenStack Dashboard page.

Deployment
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Uploading the qcow2 image
Procedure

1. Log in to the OpenStack dashboard.

2. In the navigation pane, click Project > Compute > Images.

3. On the Images page, click Create Image.

The system displays the Create An Image dialog box.

4. In the Name field, assign a name to the image.

5. In the Description field, type the description of the image.

6. In the Image Source field, select one of the following check boxes:

• Image Location: Type the URL of the qcow2 image.

• Image File : Click Browse to select the qcow2 image, and then click Open.

7. In the Format field, select QCOW2 - QEMU Emulator.
8. In the Architecture field, type x86_64.

9. In the Minimum Disk (GB) field, type the details based on the profile.

10. In the Minimum RAM (GB) field, type the details based on the profile.

11. Click Create Image.

The system displays the created image on the Images page.

Flavors
Flavors are footprints of an application. The administrator must create flavors for each application.

For information about the footprints, see the profiles and footprints information for the application.

Creating a security group
About this task
Security groups are sets of IP filter rules. Each user must create security groups to specify the
network settings for the application.

Procedure
1. Connect to OpenStack Dashboard.

2. In the left navigation pane, click Project > Compute > Access & Security.

3. On the Access & Security page, click Create Security Group.

Deploying application by using OpenStack
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The system displays the Create Security Group dialog box.

4. In Name, type the name of the security group.

5. In Description, type the description of the security group.

6. Click Create Security Group.

The system displays the created security group on the Access & Security page.

Next steps
Add rules to security group.

Adding rules to a security group
Before you begin
Create a security group.
For information about the application-specific ports and protocols, see the port matrix document at 
http://support.avaya.com/security.

Procedure
1. On the Access & Security page, click Manage Rules that is corresponding to the created

security group.

2. On the Access & Security / Manage Security Group Rules page, click Add Rule.

The system displays the Add Rule dialog box.

3. In Rule, click a rule

The system displays the fields that are associated with the selected rule.

4. Enter the appropriate values in the fields.

5. Click Add.

The system displays the created rule on the Access & Security / Manage Security Group
Rules page.

Deploying the application by using OpenStack
Before you begin

• Create flavors.
• Create a security group.

Procedure
1. Log in to the OpenStack dashboard.

2. In the navigation pane, click Project > Compute > Instances.

Deployment
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3. On the Instance page, click Launch Instance.

The system displays the Launch Instance dialog box.

4. In the Details section, do the following:

a. In the Instance Name field, assign a name to the instance.

b. In the Availability zone field, select the availability zone.

c. Click Next.
5. In the Source section, do the following:

a. In the Available field, select the check box corresponding to an instance image.

The system displays the selected image in the Allocated field.

b. Click Next.
6. In the Flavors section, do the following:

a. In the Available field, select a check box corresponding to a flavor.

The system displays the selected flavor in the Allocated field.

b. Click Next.
7. In the Networks section, do the following:

a. In the Available field, select a check box corresponding to a network.

The system displays the selected network in the Allocated field.

b. Click Next.
8. In the Network Ports section, retain the default settings, and click Next.
9. In the Security Groups section, do the following:

a. In the Available field, select a check box corresponding to a security group.

The system displays the selected security group in the Allocated field.

b. Click Next.
10. In the Key Pair section, retain the default settings, and click Next.
11. In the Configuration section, retain the default settings, and click Next.
12. In the Metadata section, retain the default settings.

13. Click Launch Instance.

The system displays the created instance on the Instances page.

14. Note down the Management IP address of the virtual machine.

This IP address is for eth0.

15. When the Status field shows Running, attach another network interface:

a. Select the virtual machine, and click Create Snapshot > Attach interface.

Deploying application by using OpenStack
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b. In the Network field, enter the network name.
c. Click Attach Interface.

16. Note down the IP address that the system populates.

This IP address is for eth1.

17. Configure the Avaya Breeze® platform details in System Manager.

18. Ensure that the FQDN entries of the Management IP address are configured in System
Manager or in DNS.

19. Configure Avaya Breeze® platform.

20. Repeat Step 3 to Step 19 to start another Avaya Breeze® platform instance on OpenStack.

21. Configure the Avaya Breeze® platform cluster for more than one Avaya Breeze® platform
instance.

Related links
Configuring the virtual machine on page 30

Configuring the Avaya Breeze® platform cluster
About this task
Use this procedure when you have deployed more than one Avaya Breeze® platform instance.

Procedure
1. Log in to the OpenStack CLI.

2. To create a port for the cluster, run the command: neutron port-create <port
name>.

For example, neutron port-create Lab_Public_Network.
neutron CLI is deprecated and will be removed in the future. Use openstack CLI 
instead.
Created a new port:
+-----------------------
+---------------------------------------------------------------------------------
-----+
| Field                 | 
Value                                                                             
   |
+-----------------------
+---------------------------------------------------------------------------------
-----+
| admin_state_up        | 
True                                                                              
   |
| allowed_address_pairs 
|                                                                                 
     |
| binding:host_id       
|                                                                                 
     |
| binding:profile       | 
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{}                                                                                
   |
| binding:vif_details   | 
{}                                                                                
   |
| binding:vif_type      | 
unbound                                                                           
   |
| binding:vnic_type     | 
normal                                                                            
   |
| created_at            | 
2017-09-13T07:27:40                                                               
   |
| description           
|                                                                                 
     |
| device_id             
|                                                                                 
     |
| device_owner          
|                                                                                 
     |
| extra_dhcp_opts       
|                                                                                 
     |
| fixed_ips             | {"subnet_id": "8372210e-e019-4d38-b40d-4e4c04cc9cb6", 
"ip_address": "10.133.51.175"} |
| id                    | dd7aacce-
f22c-447d-9116-2e182d04a742                                                 |
| mac_address           | fa:
16:3e:c6:21:49                                                                    
|
| name                  
|                                                                                 
     |
| network_id            | 33f709ce-974a-4f1a-
ad74-23a2e5113c4f                                                 |
| port_security_enabled | 
True                                                                              
   |
| security_groups       | 
e8bd3ea8-846b-4724-8a12-43d4ae03df15                                              
   |
| status                | 
DOWN                                                                              
   |
| tenant_id             | 
f554311a7ce54a75a18b1ba8eb7bf03b                                                  
   |
| updated_at            | 
2017-09-13T07:27:40                                                               
   |
+-----------------------
+---------------------------------------------------------------------------------
-----+

The system assigns a cluster IP address.

Ensure that this IP address is not associated to any other virtual machine.
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3. For the security module port of the Avaya Breeze® platform virtual machines (eth1), add
the cluster IP address as the address pair.

a. To view the port IDs, run the command: neutron port-list | grep
<securitymoduleIP>.

For example, neutron port-list | grep 10.133.51.173.
neutron CLI is deprecated and will be removed in the future. Use openstack 
CLI instead.
| 76489c2e-68f4-4e1c-bd5d-4f4dbc3398fc | | f554311a7ce54a75a18b1ba8eb7bf03b 
| fa:16:3e:26:4a:31 | {"subnet_id": "8372210e-e019-4d38-b40d-4e4c04cc9cb6", 
"ip_address": "10.133.51.173"} |

b. For each port ID, run the command: neutron port-update <securitymodule-
portid> --allowed_address_pairs list=true type=dict
ip_address=<CLUSTERIP>.

For example, neutron port-update 76489c2e-68f4-4e1c-
bd5d-4f4dbc3398fc --allowed_address_pairs list=true type=dict
ip_address=10.133.51.175.
neutron CLI is deprecated and will be removed in the future. Use openstack 
CLI instead.
Updated port: 76489c2e-68f4-4e1c-bd5d-4f4dbc3398fc

4. Configure the Avaya Breeze® platform server in System Manager.

5. Repeat Step 2 to Step 4 for each Avaya Breeze® platform server.

6. Create an Avaya Breeze® platform cluster in System Manager.

Deploying application by using Nutanix

Logging on to the Nutanix Web console
Procedure

1. To log on to the Nutanix Web console, in your web browser, type the PRISM URL.

For example, http://<PRISM_IPAddress>/.

2. In username, type the user name.

3. In password, type the password.

4. Press Enter.

The system displays the Home page.
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Transferring the qcow2 image
Procedure

1. Use WinSCP or a similar file transfer utility to connect to the Nutanix container.

2. Transfer the qcow2 image from your system to the Nutanix container.

Uploading the qcow2 image
Procedure

1. Log on to the Nutanix Web console.

2. Click Settings icon ( ) > Image Configuration.

The system displays the Image Configuration dialog box.

3. Click + Upload Image.

The system displays the Create Image dialog box.

4. In NAME, type the name of the image.

5. In ANNOTATION, type the description of the image.

6. In IMAGE TYPE, click DISK.

7. In STORAGE CONTAINER, click the storage container of the image.

8. In IMAGE SOURCE, perform one of the following:

• Select From URL, type the exact URL of the qcow2 image. For example: nfs://
<127.0.0.1>/<Storage Container Name>/<Image Name>

• Select Upload a file, click Browse. In the Choose File to Upload dialog box, select the
qcow2 image from your local system, and click Open.

9. Click Save.

The system displays the created image on Image Configuration.

Creating the virtual machine by using Nutanix
Before you begin

• Upload the qcow2 image.

• Configure the network.
• Create the network for High Availability (HA).

Deploying application by using Nutanix
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Procedure
1. Log on to the Nutanix Web console.

2. Click Home > VM.

3. Click + Create VM.

The system displays the Create VM dialog box.

4. In the General Configuration section, perform the following:

a. In NAME, type the name of the virtual machine.

b. In DESCRIPTION, type the description of the virtual machine.

5. In the Compute Details section, perform the following:

a. In VCPU(S), type the number of virtual CPUs required for the virtual machine.

b. In NUMBER OF CORES PER VCPU, type the number of core virtual CPUs required
for the virtual machine.

c. In Memory, type the memory required for the virtual machine.

The value must be in GiB.

You must select the CPU and Memory according to the application footprint profile.

6. In the Disk section, perform the following:

a. Click + Add New Disk.

The system displays the Add Disk dialog box.

b. In TYPE, click DISK.

c. In OPERATION, click Clone from Image Service.

d. In IMAGE, click the application image.

e. In BUS TYPE, click IDE.

f. Click Add.

The system displays the added disk in the Disk section.

7. In the Disk section, select a boot device.

8. In the Network Adopters (NIC) section, perform the following:

a. Click Add New NIC.

The system displays the Create NIC dialog box.

b. In VLAN NAME, click the appropriate NIC.

The system displays VLAN ID, VLAN UUID, and NETWORK ADDRESS / PREFIX for
the selected NIC.

c. Click Add.

The system displays the added NIC in the Network Adopters (NIC) section.
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You must select one more NIC for configuring Out of Band Management.

9. In the VM Host Affinity section, perform the following:

a. Click Set Affinity.

The system displays the Set VM Host Affinity dialog box.

b. Select one or more host to deploy the virtual machine.

For the HA deployment where both the systems need to be connected directly:

• Select the same host for both the virtual machines.

• Duplication link must use the network that is created for HA.

c. Click Save.

The system displays the added hosts in the VM Host Affinity section.

10. Click Save.

The system displays the message: Received operation to create VM <name of
the VM>.

After the operation is successful, the system displays the created virtual machine on the
VM page.

Next steps
Start the virtual machine.

Starting a virtual machine
Before you begin
Create the virtual machine.

Procedure
1. Click Home > VM.

2. On the VM page, click Table.

3. Select the virtual machine.

4. At the bottom of the table, click Power On.

The system starts the virtual machine.

Next steps
Launch the console. On the first boot of the virtual machine, provide the configuration and
networking parameters

Related links
Configuring the virtual machine on page 30
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Deploying application by using Red Hat Virtualization
Manager

Logging on to the Red Hat Virtualization Manager Web console
Procedure

1. In your web browser, type the Red Hat Virtualization Manager URL.

For example, https://<RedHatVirtualizationManager_IPAddress>/ovirt-engine/.

2. To log in, click Not Logged In > Login.

The system displays the Red Hat Virtualization Manager Log In page.

3. In Username, type the user name.

4. In Password, type the password.

5. In Profile, click the appropriate profile.

6. Click Log In.

The system displays the Red Hat Virtualization Manager Web Administration page.

Uploading the disk
Before you begin
You must import the ovirt-engine certificate into your browser by accessing the http://
<engine_url>/ovirt-engine/services/pki-resource?resource=ca-
certificate&format=X509-PEM-CA link to get the certificate. Establish the trust for the new
Certificate Authority (CA) with the website.

Procedure
1. Log on to the Red Hat Virtualization Manager Web console.

2. In the left navigation pane, click System.

3. On the Disks tab, click Upload > Start.

The system displays the Upload Image dialog box.

4. Click Browse.

5. In the Choose File to Upload dialog box, select the qcow2 disk image from your local
system, and click Open.

6. In Size(GB), type the size of the disk.

7. In Alias, type the name of the disk.
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8. In Description, type the description of the disk.

9. In Data Center, click the data center to store the disk.

10. In Storage Domain, click the storage domain of the disk.

11. In Disk Profile, click disk profile.

12. In Use Host, click the host of the disk.

13. Click OK.

The system displays the uploaded image on the Disks tab. Once the disk image is
successfully uploaded, the Status column displays OK.

Creating the virtual machine by using Red Hat Virtualization
Manager

Before you begin
• Upload the qcow2 disk image.

• Create an instance type.
• Configure the network.

Procedure
1. Log on to the Red Hat Virtualization Manager Web console.

2. In the left navigation pane, click System.

3. On the Virtual Machines tab, click New VM.

The system displays the New Virtual Machine dialog box.

4. In Operating System, click Linux.

5. In Instance Type, click an instance type.

You must select the instance type according to the application footprint profile.

6. In Optimized for, click Server.
7. In Name, type the name of the virtual machine.

8. In Description, type the description of the virtual machine.

9. In the Instance Images section, perform the following:

a. Click Attach.

The system displays the Attach Virtual Disks dialog box.

b. In Interface, click VirtIO.

c. Click OK.

The system displays the added disk in the Instance Images section.
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10. In nic1, click a vNIC profile for management IP address.

11. In nic2, click a vNIC profile for security module IP address.

12. Click OK.

After the operation is successful, the system displays the created virtual machine on the
Virtual Machines tab.

Next steps
Start the virtual machine.

Starting a virtual machine
Before you begin
Create the virtual machine.

Procedure
Right-click the virtual machine and click Run.

When the system starts the virtual machine, the system displays a green upward arrow key ( )
corresponding to the virtual machine name.

Next steps
Launch the console. On the first boot of the virtual machine, provide the configuration and
networking parameters

Related links
Configuring the virtual machine on page 30
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Chapter 5: Configuration

Changing the Avaya Breeze® platform profile
Procedure

1. To change the Avaya Breeze® platform profile using KVM host:

a. To power off the virtual machine, run the command: virsh shutdown <VM name>.

b. Determine the location of the hard disk image.

c. To view the current image size, run the command: qemu-img info /var/lib/
libvirt/images/<image name>.

d. Based on the profile, determine the required disk increase if needed.

For example, if you are changing from Profile 2 to Profile 4, you need to add 70G.
Profile 2 to Profile 3 would not require an increase of the disk.

e. To increase the disk size, run the command: qemu-img resize /var/lib/
libvirt/images/<hard disk image> +70G.

f. To change the number CPUs to match the profile: run the command: virsh edit
<VM name> and change the value of vcpu.

For example:
<vcpu placement='static'>6</vcpu>

g. To change the memory to match the profile, run the commands:

• virsh setmaxmem <VM name> 8G --config
• virsh setmem <VM name> 8G --config

h. Run the command: virsh start <VM name>.

2. To change the Avaya Breeze® platform profile using OpenStack:

a. Log in to the OpenStack dashboard.

b. Select the virtual machine, and click Create Snapshot > Resize instance.

c. Select the new flavor.

d. Click Confirm Resize/Migrate.

e. Verify that the status of the virtual machine shows Running.
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Configuring the virtual machine
Procedure

1. Start the virtual machine and access the Console.

2. When the system prompts to configure the virtual machine, enter yes.

3. To accept the End User License Agreement, scroll to the end using the Spacebar key,
and enter yes.

4. When the system prompts, enter the configuration information.

See “Key customer configuration information”.

To alter the configuration settings later, see Maintaining and Troubleshooting Avaya
Breeze® platform.

5. Run the CEnetSetup command to change the value of any OVA property specified during
deployment.
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Chapter 6: Resources

Documentation
See the following related documents at http://support.avaya.com.

Title Use this document to: Audience
Understanding
Avaya Breeze® platform Overview
and Specification

Understand the Avaya Breeze® platform
platform, customer requirements, and
design considerations.

Sales engineers

Programmers

System
administrators

Services and support
personnel

Avaya Aura® System Manager
Overview and Specification

Understand System Manager customer
requirements and design considerations.

Sales engineers

Programmers

System
administrators

Services and support
personnel

Implementing
Deploying Avaya Breeze® platform Deploy and configure Avaya Breeze®

platform.
Services and support
personnel

System
administrators

Deploying Zang-Enabled Avaya
Breeze® platform

Deploy and configure Zang-enabled Avaya
Breeze® platform.

Services and support
personnel

System
administrators

Upgrading Avaya Breeze® platform Upgrade Avaya Breeze® platform. Services and support
personnel

Implementing and Administering
Avaya Aura® Media Server

Deploy and configure Avaya Aura® Media
Server.

System
administrators

Table continues…
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Title Use this document to: Audience
Services and support
personnel

Deploying and Updating Avaya
Aura® Media Server Appliance

Deploy and configure Avaya Aura® Media
Server when it is installed on customer-
provided servers.

System
administrators

Services and support
personnel

Deploying Avaya Aura® System
Manager

Deploy and configure Avaya Aura® System
Manager in a virtualized environment using
VMware.

System
administrators

Services and support
personnel

Avaya Aura® System Manager
Solution Deployment Manager Job-
Aid

Use Solution Deployment Manager. System
administrators

Services and support
personnel

Migrating and Installing Avaya Aura®

Appliance Virtualization Platform
Deploy and configure Avaya Aura®

Appliance Virtualization Platform.
System
administrators

Services and support
personnel

Deploying Avaya Session Border
Controller for Enterprise

Deploy and configure Avaya Aura® Session
Border Controller.

System
administrators

Services and support
personnel

Customizing
Getting Started with the Avaya
Breeze® platform SDK

Deploy and configure the Eclipse IDE,
Apache Maven, and the Avaya Breeze®

platform SDK.

Programmers

Avaya Breeze® platform Snap-in
Development Guide

Understand the key concepts needed to
develop the different types of Avaya
Breeze® platform snap-ins.

Programmers

Avaya Breeze® platform FAQ and
Troubleshooting for Snap-in
Developers

Troubleshoot Avaya Breeze® platform. Programmers

Avaya Breeze® platform API
Javadocs

Understand API classes and uses. Programmers

Supporting
Maintaining and Troubleshooting
Avaya Breeze® platform

Troubleshoot Avaya Breeze® platform. Services and support
personnel

System
administrators

Troubleshooting Avaya Aura®

Session Manager
Troubleshoot Avaya Aura® Session
Manager.

Services and support
personnel

Table continues…
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Title Use this document to: Audience
Troubleshooting Avaya Aura®

System Manager
Troubleshoot System Manager. Services and support

personnel
Using
Quick Start to deploying the
HelloWorld Snap-in

Install, configure, and test an Avaya
Breeze® platform snap-in service,
specifically the HelloWorld call-intercept
snap-in.

Programmers

System
administrators

Administering Avaya Breeze®

platform
Administer Avaya Breeze® platform and
snap-ins.

System
Administrators

Services and Support
personnel

Administering Avaya Aura® Session
Manager

Administer Avaya Aura® Session Manager. System
Administrators

Services and support
personnel

Administering Avaya Aura® System
Manager

Administer Avaya Aura® System Manager. System
Administrators

Services and support
personnel

Administering Avaya Session Border
Controller for Enterprise

Administer Avaya Aura® Session Border
Controller.

System
Administrators

Services and support
personnel

Finding documents on the Avaya Support website
Procedure

1. Go to https://support.avaya.com/.

2. At the top of the screen, type your username and password and click Login.

3. Click Support by Product > Documents.

4. In Enter your Product Here, type the product name and then select the product from the
list.

5. In Choose Release, select an appropriate release number.

6. In the Content Type filter, click a document type, or click Select All to see a list of all
available documents.

For example, for user guides, click User Guides in the Content Type filter. The list
displays the documents only from the selected category.

7. Click Enter.

Documentation
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Training
The following courses are available on the Avaya Learning website at http://www.avaya-
learning.com. After logging in to the website, enter the course code or the course title in the
Search field, and click Go to search for the course.

Course code Course title
2016W Fundamentals of Avaya Breeze® platform
2316W Avaya Breeze® platform Client SDK Fundamentals
2024V Programming Avaya Breeze® platform Snap-ins using Java SDK Bootcamp
2024T Programming Avaya Breeze® platform Snap-ins using Java SDK Online Test
20250V Programming Avaya Breeze® platform Snap-ins using Engagement Designer
20250T Programming Avaya Breeze® platform R3 Snap-ins using Engagement Designer

Online Test
5105 Avaya Breeze® platform Implementation and Support Test
7016W Avaya Breeze® platform Implementation and Support

Viewing Avaya Mentor videos
Avaya Mentor videos provide technical content on how to install, configure, and troubleshoot
Avaya products.

About this task
Videos are available on the Avaya Support website, listed under the video document type, and on
the Avaya-run channel on YouTube.

Procedure
• To find videos on the Avaya Support website, go to https://support.avaya.com/ and do one of

the following:

- In Search, type Avaya Mentor Videos to see a list of the available videos.

- In Search, type the product name. On the Search Results page, select Video in the
Content Type column on the left.

• To find the Avaya Mentor videos on YouTube, go to www.youtube.com/AvayaMentor and do
one of the following:

- Enter a key word or key words in the Search Channel to search for a specific product or
topic.

- Scroll down Playlists, and click the name of a topic to see the available list of videos
posted on the website.

Note:

Videos are not available for all products.

Resources
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Support
Go to the Avaya Support website at https://support.avaya.com for the most up-to-date
documentation, product notices, and knowledge articles. You can also search for release notes,
downloads, and resolutions to issues. Use the online service request system to create a service
request. Chat with live agents to get answers to questions, or request an agent to connect you to a
support team if an issue requires additional expertise.

Using the Avaya InSite Knowledge Base
The Avaya InSite Knowledge Base is a web-based search engine that provides:

• Up-to-date troubleshooting procedures and technical tips

• Information about service packs

• Access to customer and technical documentation

• Information about training and certification programs

• Links to other pertinent information

If you are an authorized Avaya Partner or a current Avaya customer with a support contract, you
can access the Knowledge Base without extra cost. You must have a login account and a valid
Sold-To number.

Use the Avaya InSite Knowledge Base for any potential solutions to problems.

1. Go to http://www.avaya.com/support.
2. Log on to the Avaya website with a valid Avaya user ID and password.

The system displays the Avaya Support page.
3. Click Support by Product > Product Specific Support.
4. In Enter Product Name, enter the product, and press Enter.

5. Select the product from the list, and select a release.
6. Click the Technical Solutions tab to see articles.
7. Select relevant articles.

Support

December 2018 Deploying Avaya Breeze® platform on Kernel-based Virtual Machine 35
Comments on this document? infodev@avaya.com

https://support.avaya.com
http://www.avaya.com/support
mailto:infodev@avaya.com?subject=Deploying Avaya Breeze® platform on Kernel-based Virtual Machine


Index

A
adding

rule ................................................................................18
add rules

security group ............................................................... 18
Avaya support website support ............................................35

C
cluster

configuring .................................................................... 20
configuration information ......................................................11
configuration tools ................................................................10
connecting

OpenStack Dashboard ................................................. 16
creating

application virtual machine ..................................... 23, 27
security group ............................................................... 17

customer configuration information ......................................11

D
deploying

CLI ................................................................................ 15
KVM OVA by using Virt Manager ..................................14

Deploying
Openstack .................................................................... 18

E
extracting

KVM OVA ......................................................................14

F
flavor .................................................................................... 17
footprints .............................................................................. 10

I
InSite Knowledge Base ........................................................35

K
KVM ....................................................................................... 8

footprints .......................................................................10
KVM OVA

Release version ............................................................10

L
log on

Nutanix Web console ....................................................22
Red Hat Virtualization Manager Web console .............. 26

N
Nutanix ...................................................................................9

O
Openstack ..............................................................................9

P
planning checklist .................................................................. 9
power on VM ........................................................................25
prerequisites .......................................................................... 7
profile

changing ....................................................................... 29

Q
qcow2 image ........................................................................17

R
Red Hat Virtualization Manager .............................................9
run virtual machine .............................................................. 28

S
start VM ............................................................................... 25
support .................................................................................35
supported hardware ............................................................. 11

T
tools ....................................................................................... 9
training ................................................................................. 34
Transferring ..........................................................................23

U
uploading

qcow2 disk image on Red Hat Virtualization ................ 26
qcow2 image on Nutanix .............................................. 23

December 2018 Deploying Avaya Breeze® platform on Kernel-based Virtual Machine 36
Comments on this document? infodev@avaya.com

mailto:infodev@avaya.com?subject=Deploying Avaya Breeze® platform on Kernel-based Virtual Machine


V
videos .................................................................................. 34
virsh ....................................................................................... 9
Virt Manager .......................................................................... 9
virtual machine

configuring .................................................................... 30

Index

December 2018 Deploying Avaya Breeze® platform on Kernel-based Virtual Machine 37
Comments on this document? infodev@avaya.com

mailto:infodev@avaya.com?subject=Deploying Avaya Breeze® platform on Kernel-based Virtual Machine

	Contents
	Chapter 1: Introduction
	Purpose
	Prerequisites

	Chapter 2: Overview
	Kernel-based Virtual Machine overview

	Chapter 3: Planning
	Planning checklist
	Supported tools
	Configuration tools and utilities
	Release details of Avaya Breeze® platform KVM OVA
	Supported footprints
	Supported hardware
	Key customer configuration information

	Chapter 4: Deployment
	Prerequisites for deploying KVM OVA
	Deploying the OVA by using Virt Manager
	Deploying the OVA by using CLI
	Deploying application by using OpenStack
	Connecting to OpenStack Dashboard
	Uploading the qcow2 image
	Flavors
	Creating a security group
	Adding rules to a security group
	Deploying the application by using OpenStack
	Configuring the Avaya Breeze® platform cluster

	Deploying application by using Nutanix
	Logging on to the Nutanix Web console
	Transferring the qcow2 image
	Uploading the qcow2 image
	Creating the virtual machine by using Nutanix
	Starting a virtual machine

	Deploying application by using Red Hat Virtualization Manager
	Logging on to the Red Hat Virtualization Manager Web console
	Uploading the disk
	Creating the virtual machine by using Red Hat Virtualization Manager
	Starting a virtual machine


	Chapter 5: Configuration
	Changing the Avaya Breeze® platform profile
	Configuring the virtual machine

	Chapter 6: Resources
	Documentation
	Finding documents on the Avaya Support website

	Training
	Viewing Avaya Mentor videos

	Support
	Using the Avaya InSite Knowledge Base


	Index

